


ii

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other 
printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials

Digital cameras and scanners, like photocopiers, conventional cameras, and ink jet printers, can be misused by 
improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of 
copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. 
EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras, 
scanners, and ink jet printers.

Trademarks
EPSON, EPSON Stylus, EPSON Photo Stickers, and MicroWeave are registered trademarks of SEIKO EPSON 
CORPORATION.

EPSON Print Lab, EPSON PhotoCenter, EPSON Store, and SoundAdvice are service marks, and Resolution 
Performance Management, RPM, EPSON Software, and PhotoEnhance are trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

 Printed on recycled paper 

Copyright © 2002 by Epson America, Inc. 7/02 CPD-14477



iii

Contents

Welcome! 1

About Your Software 2

About Your Documentation 3

Using the EPSON Printer Information Center 4

Launching the Movies 4

Launching the Manual 5

Printing From Start to Finish 7

Loading Paper 8

Loading Envelopes 9

Basic Printing in Windows 10

Selecting the Settings You Use Most Often 12

Basic Printing on a Macintosh 12

Printing with OS 8.5.1 to 9.x 12

Printing with OS X 14

Customizing Your Print Settings 17

Customizing Windows Print Settings 17

Customizing Macintosh Print Settings 19

Selecting the Correct Media Type 21

Using Film Factory 22

Using Exif Print 22



iv Contents

Maintaining Your Printer 27

Cleaning the Print Head 27

Running the Head Cleaning Utility 28

Examining the Nozzle Check Pattern 29

Replacing an Ink Cartridge 29

Checking the Ink Supply 29

Purchasing Ink Cartridges 30

Ink Cartridge Precautions 30

Removing and Installing Ink Cartridges 31

Aligning the Print Head 34

Cleaning the Printer  35

Transporting the Printer  36

Solving Problems 37

Printer Parts 38

Diagnosing Printer Problems 39

Running a Printer Check 40

Problems and Solutions 41

Setup and Software Installation Problems 41

Printer Problems 42

Print Quality Problems 43

Paper Feeding Problems 45

Miscellaneous Printout Problems 45

Uninstalling and Reinstalling Printer Software  47

Where To Get Help 48

Installing Your Printer Software 49

Installing Printer Software on Mac OS X 49

Installing Printer Software for Mac OS 9.x 52

Installing Printer Software on Windows 2000 53

Installing Printer Software on Windows 95 55



Contents v

Requirements and Notices 57

Windows System Requirements 57

Macintosh System Requirements 58

ENERGY STAR Compliance 58

Important Safety Instructions 59

Ink Cartridge Safety Instructions 60

FCC Compliance Statement 61

Declaration of Conformity 62

Epson America, Inc. Limited Warranty 62

Index 65



1

Welcome!

Your EPSON Stylus® C62 printer is ideal for personal or home office use. It provides 
you with these great features:

� Exceptionally high print quality for printing anything from reports and resumes 
to family photos and greeting cards.

� Resolution Performance Management™ (RPM) technology, which optimizes the 
number and placement of ink droplets on a variety of paper types, and delivers 
superior photo quality and performance with manageable print file sizes. 

� Versatile paper handling lets you print on a wide variety of media, from EPSON® 
Premium Bright White Paper to EPSON Matte Paper Heavyweight.

� Genuine EPSON ink and papers deliver the highest quality prints.
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About Your Software

The CD-ROM that came with your printer includes all the software you need for 
printing. (You must have a CD-ROM or DVD drive installed in your computer.) See 
the Start Here sheet for installation instructions.

� Your printer driver runs your printer and lets you control how your documents 
look. You can’t print without it.

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

� Your EPSON Printer Information Center gives you quick, 
on-screen access to information about your printer. It includes 
EPSON Print Show, animated tutorials on loading paper, 
improving print speed, and other tasks. It also includes your 
on-screen Reference Guide for complete information about your 
printer. (The desktop icon may be different on some Mac® OS X 
systems.)

� EPSON Software™ Film Factory™ is a photo management 
program that lets you organize, beautify, and print your photos 
in a flash. Supports Exif Print. See page 22 for more information.

� EPSON PhotoCenter  is EPSON’s free photo-sharing web site 
where you can store, organize, and share your photos; print 
high-resolution photos straight from the web; and create free online 
postcards with your photos. Your printer software installer lets you 
add a link to the EPSON PhotoCenter on your desktop.

SM
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About Your Documentation

To set up your printer and install its software, see the Start Here sheet. 

This book contains system requirements, important safety information, your 
warranty, and instructions on:

� Using the EPSON Printer Information Center

� Printing with Windows® or on a Macintosh® 

� Maintaining the printer

� Solving basic problems

Please follow these guidelines throughout:

Warning: must be followed carefully to avoid bodily injury.

Caution: must be observed to avoid damage to your equipment.

Note: contains important information about your printer.

Tip: contains additional hints for better printing.

For more information on your printer, use your EPSON Printer Information Center, 
described on page 4.
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Using the EPSON Printer Information 
Center

Need help loading paper, clearing a paper jam, or cleaning the print head? Use the 
EPSON Printer Information Center (EPIC) to view printer movies that quickly tell 
you how. EPIC also includes an on-screen Reference Guide with additional printer 
details. Follow the instructions on the Start Here sheet to install the EPSON Printer 
Information Center, if you haven’t already.

Note: You need a browser—such as Microsoft® Internet Explorer 4.0 or later or 
Netscape® Navigator® 3.0 or later—to view the Reference Guide. If you are using 
a different browser, the pages may not display correctly.

Launching the Movies

1. Double-click the  EPSON Printer Information Center icon on your desktop. 
(The desktop icon may be different on some Mac OS X systems.)

2. Click Print Show.

Click Print Show
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3. Click the appropriate topic, then click the title of the movie you want to watch.

Use the program tools to pause a movie, replay a step, or skip ahead.

4. Click Exit to exit Print Show.

Launching the Manual

1. Double-click the  EPSON Printer Information Center icon on your desktop. 

2. Click Reference Guide. You see this screen:

3. Click a topic on the left to expand the table of contents. 

Click a topic, to 
view a movie

Click here 
to expand 
the table of 
contents
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4. Click on the topic you want to view.

� Click right arrows  to view subtopics, then click on a topic.

� Click down arrows to close subtopic lists.

Note: If you see an icon for a graphic when viewing your Reference Guide in 
Netscape Navigator, click the Reload button to load the graphic.

Closed list, 
click to 
expand

Click to go 
to topic
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Printing From Start to Finish

Follow the instructions in these sections to print using all your printer’s features:

� “Loading Paper” on page 8

� “Basic Printing in Windows” on page 10

� “Basic Printing on a Macintosh” on page 12

� “Customizing Your Print Settings” on page 17

� “Selecting the Correct Media Type” on page 21

� “Using Film Factory” on page 22

� “Using Exif Print” on page 22

Tip: Whenever you print, make sure you:

� Use the right paper.
For the best-looking photos, most vivid colors, sharpest text, and greatest detail, 
always use genuine EPSON papers and EPSON ink.

� Choose the right printer settings for the paper.
Your printer automatically adjusts itself for each type of document and paper 
you’ve selected, so make sure your printer settings are correct for the document 
you’re printing and the paper you’ve loaded.
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Loading Paper

1. Press in the locking tab on the left edge guide and slide it to the approximate 
width of your paper.

2. Place paper in your printer on the right side of the sheet feeder, behind the tab.

3. Slide the left edge guide lightly against the paper.

4. Pull out the output tray extension.

Follow these guidelines when loading paper:

� Always load the short edge first, even when you’re printing landscape-oriented 
documents.

� Load the printable side face up. It’s usually whiter or brighter than the other side.

� Load letterhead or pre-printed paper into the printer top edge first.

� Don’t load paper above the arrow on the left edge guide.

See your Print Show movies for additional instructions on loading paper. 
Double-click the EPSON Printer Information Center icon on your desktop.

Load paper 
behind the tab

Press the locking 
tab and slide the 
left edge guide 
against the paper
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Loading Envelopes

1. Load up to 10 envelopes, short edge first and printable side up.

Tip: For best results, press each envelope flat before loading it, or load one 
envelope at a time.

2. Place the envelope’s flap edge against the right edge of the sheet feeder, 
behind the tab. 

3. Press the locking tab on the left edge guide and slide it against the envelopes.

Before you print, make sure you choose the correct envelope size as the paper Size 
(Windows) or Paper Size (Macintosh) setting and Landscape as the Orientation. 
See page 11 (Windows), page 12 (Macintosh OS 8.5.1 to 9.x), or page 14 
(Macintosh OS X) for instructions.

Load with the 
printable side up
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Basic Printing in Windows

After you create a document in a software program, follow these steps to print it:

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus C62 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Click here to open 
your printer software

Select your printer here
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4. Select the following settings on the Main tab in your printer settings window.

The most important thing to remember is to set the correct paper Type for the 
paper you’re using. 

Tip: For more information about printer settings, click the  or Help button.

5. You return to the Print window. Click OK or Print to start printing.

After a moment, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or resume printing. You can also see how much 
ink you have left.

1 Select the type of document you’re printing:

Draft: for rough drafts with 
reduced print quality

Text: For text-only 
documents with higher text 
quality

Text & Image: For 
documents with text and 
images with higher quality

Photo: For photos and 
graphics with good quality 
and speed

Best Photo: For photos or 
graphics with high print 
quality

2 Select your paper 
type (see page 21)

3 Select your paper 
size

4 Select your 
document or 
image orientation

5 Click OK

Click to cancel printing

Click to pause or
resume printing
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Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you want, 
you can change the default Windows printer settings for all your programs. 

1. Right-click the  printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown on page 11.

3. Select the default settings you want for all your applications, then click OK.

You can always change the settings in your program, if necessary.

Basic Printing on a Macintosh

After you create a document in a software program, follow the steps in one of these 
sections to print it:

� For Macintosh OS 8.5.1 to 9.x applications, see the next section.

� For Macintosh OS X applications, see page 14.

Printing with OS 8.5.1 to 9.x

1. From the File menu, select Page Setup. Select the following settings:

2. Click OK to close the Page Setup window. 

1 Make sure you see C62 Series

2 Select your paper size

3 Select the orientation 
of your document
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3. From the File menu, select Print. Select the following settings:

Tip: For more information about printer settings, click the  button.

4. You can also do the following:

� Click  to reduce/enlarge, print multi-page layouts, or add a watermark.

� Click  to turn on background printing. 

� Click , then click Preview to preview your printout.

� Click  to check your ink levels.

5. Click Print. 

6. If you turned on background printing, you can select EPSON Monitor3 from the 
Application menu in the right corner of the screen. You see the EPSON 
Monitor3 window:

Note: If you’re not using background printing and you need to cancel printing, 
hold down the 

 

J key and press the . (period) key.

1 Select your paper type
(see page 21)

3 Select Automatic mode

2 Select Color (for color 
documents and black 
and white photographs) 
or Black (for black text 
documents)

4 Select Quality or Speed 
(for faster printing)

Select your print job, then click here to cancel printing Click to check ink levels
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Printing with OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh Classic mode, follow the steps on page 12 instead.)

Before you begin, make sure you added your printer to Print Center as described in 
“Installing Printer Software on Mac OS X” on page 49.

1. From the File menu, select Page Setup.

2. Select the following Page Setup settings as necessary:

3. When you’re finished, click OK.

4. Select Print from the File menu. You see a screen like this:

5. Select Print Settings from the pull-down menu.

Select C62 Series (USB) 
from the Format for 
pop-up menu

Select the Paper Size, 
Orientation, and any other 
settings you want to use

Click here and 
select Print 
Settings
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6. Select the following Print Settings as necessary:

Tip: For more information about printer settings, click Help. The OS X printer 
driver contains a subset of the settings available with the OS 8.5.1 to 9.x 
Macintosh printer driver described in this book.

7. You can also choose other print settings by selecting these options in the 
pull-down menu:

� Copies & Pages, to select the number of copies or a page range

� Layout, to select page layout options

� Output Options, to save your print job as a PDF file

� Color Management, to select ColorSync,® adjust the color controls, change
the gamma setting, or turn off color adjustments by the printer software

� Summary, to view a list of all your selections

� Save Custom Setting, to save your selections for future use.

8. Click Print.

1 Select your paper type 
(see page 21)

2 Select Color (for color 
documents and black 
and white photographs) 
or Black (for black text 
documents)

3 Select Automatic mode

4 Select Quality or Speed 
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9. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock on the bottom of your desktop. You see a screen like this:

10. Monitor the progress of your print job or do one of the following:

� Click the print job, then click Delete to delete the job.

� Click the print job then click Hold to pause printing.

� Click a print job marked “Hold” and click Resume to resume printing.

� If multiple print jobs are listed, click a print job, then click the Priority arrow 
as necessary to reorder the jobs.

11. When you’re finished, close Print Center.
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Customizing Your Print Settings

You can use advanced settings for color matching, printing at higher resolutions, or 
selecting a variety of special effects and layouts.

Customizing Windows Print Settings

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window. The Basic settings change to the Advanced settings. 

2. Select the following advanced settings:

3. Once you’ve finished selecting advanced settings, you can:

� Click OK to save your settings, return to the Print dialog box, and print.

� Click the Basic button to return to the Basic settings.

� Click the Page Layout tab and continue with step 4 to select layout options.

Note: For more information about advanced settings, or instructions on saving 
them as a group so you can reuse them later, click the Help or  button. If you 
want to use the Advanced screen each time you access your printer settings, 
select the Show this screen first checkbox.

3 Select a color
management 
method

To choose No Color 

Adjustment, click 
ICM first

1 Select Paper & Quality 
Options as necessary

Click here to select
Photo RPM for the
best print quality on 
certain paper types

2 Select Print Options 
as necessary

Click here to select 
Black Ink Only 

printing
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4. Select the following page layout settings as necessary:

Note: For more information on page layout settings, click the Help or  button.

5. Click OK to save your settings, return to the Print dialog box, and print.

4 Select multi-page 
document options 
here and here

1 Select image position 
options here

2 Select image resizing 
options here; these 
affect only your printed 
image

3 Add a watermark to 
your printed page here

To print a large 
image on several 
sheets to make a 
poster, select poster 
settings here
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Customizing Macintosh Print Settings

1. On the printer settings window, click Custom, then click the Custom Settings 
list to open it.

Note: For more information on custom settings, click Help (OS X) or
 (OS 8.5.1 to 9.x).

2. If you’re finished selecting custom settings, click Print to print your document.

To select more custom settings, go to step 3.

3. To access advanced settings, click Custom and then click Advanced Settings 
(OS X) or Advanced (OS 8.5.1 to 9.x).

Click Custom, then choose one of the 
following:

Text/Graph or Economy (to save ink 
on plain paper) or ColorSync (to match 
printed colors with compatible device 
colors) from the Custom Settings list

Macintosh OS 8.5.1 through 9.x

Macintosh OS X

Click Custom, then choose one of the 
following:

Text/Graph or Economy (to save ink 
on plain paper) or ColorSync (to match 
printed colors with compatible device 
colors) from the Custom Settings list
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4. Select these advanced settings as necessary:

Note: For more information on advanced settings, or instructions on saving them 
as a group so you can reuse them later, click Help (OS X) or  (OS 8.5.1 to 9.x).

5. To print, click Print (OS X) or click OK to save your settings, then click 
Print (OS 8.5.1 to 9.x).

1 Click here to select 
Photo RPM for the 
best print quality on 
certain paper types

2 Select various 
print options here

3 Select color 
management 
settings here

1 Select a higher Print Quality 
here

2 Select various print options 
here

3 To select color management 
settings, select Color 
Management from the Print 
Settings pull-down menu

Macintosh OS 8.5.1 through 9.x

Macintosh OS X
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Selecting the Correct Media Type

Your printer automatically adjusts itself for the type of 
paper you select in your print settings. That’s why the 
Type or Media Type setting is so important. It tells 
your printer what kind of paper you’re using and 
adjusts the ink coverage accordingly. 

Here are the settings you should choose for your paper:

* The availability of paper types varies by location.

For this paper . . .

Select this Type or Media Type 

setting . . .

Plain paper sheets or envelopes

EPSON Premium Bright White Paper

Plain paper

EPSON Iron-On Transfer Paper 360 dpi Ink Jet Paper

EPSON High Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper Heavyweight

EPSON Photo Paper

EPSON Glossy Photo Paper

EPSON Glossy Photo Greeting Cards

EPSON Panoramic Photo Paper

EPSON All Purpose Glossy Paper

Glossy Photo Paper

EPSON Premium Glossy Photo Paper

EPSON Premium Semigloss Photo Paper

EPSON Premium Luster Photo Paper

Premium Glossy Photo Paper

EPSON Photo Stickers® Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies



22 Printing From Start to Finish

Using Film Factory

You can use Film Factory to organize, retouch, and print your digital images. If your 
digital camera supports Exif (Exchangeable Image File) Print, you can use this 
technology when you print with Film Factory to ensure the most accurate image 
reproduction (not available with Macintosh OS X).

Using Exif Print

With Exif Print, special image settings such as white balance, contrast, color 
saturation, and exposure time are saved in your digital photo files. If your digital 
camera supports Exif Print, you can use this technology when you print with Exif 
Print enabled applications such as EPSON Software Film Factory.



Printing From Start to Finish 23

Opening Your Photos in Film Factory

1. Start Film Factory. You see the main Film Factory screen:
 

Note: If you need help with Film Factory, select it from the Help menu or check 
the on-screen Getting Started Guide that was installed with Film Factory (you 
must have Adobe® Acrobat® Reader® installed on your system to view the 
manual).

2. Select a “roll of film” or click the Roll button and select New Roll.

3. If your photos were taken with a digital camera that supports Exif Print, you can 
use this technology when you print with Film Factory to ensure the most accurate 
image reproduction. Right-click (Windows) or Ctrl-click (Macintosh) a photo 
thumbnail to display information about the Exif Print data in the photo file.

4. Click the photo you want to print or click the All button at the top of the screen 
to select all the photos in a roll.

Click Roll to create a 
new roll, or . . . 
click an existing roll
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5. To import a photo into Film Factory, click the Import button, then:

� Click From File to import a photo from your computer’s hard drive.

� Click From Removable Media to import a photo from a disk or CD-ROM.

� Click From PC Card to import a photo from a PC card in a card reader.

� Click From Twain Device to import a photo from a scanner or digital 
camera. If your device is already selected, the software will open. If not, click 
Import Settings, and select your scanner or digital camera (not applicable
to OS X).

6. Click a button on the left to select a print option. For 
example, click the Standard Prints button. You see buttons 
for each step you need to follow, as shown.

7. Click Import & Retouch to retouch or edit your photo, if 
necessary.

Note: You can rotate, trim, and correct for red eyes and still 
retain Exif Print data with your photograph. However, if you 
adjust other settings, such as brightness and color, these 
settings are not retained.

8. When you’re ready to print, continue with the steps in the 
next section.
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Printing Your Photos

1. When you’re ready to print, click the Print Assignment button. You see this 
screen:

2. Windows and Macintosh OS 8.5.1 to 9.x: Select these options in the Printer 
Settings box at the bottom of the screen:

Macintosh OS X: Click the Properties button. Select your printer in the
Format for menu, select the correct Paper Size setting, and click OK.

3. If you want to print the current date with your photo, click the Print Date box.

Click to print 
the date with 
your photo

Select your printer 
settings here

1 Make sure your 
printer is selected

2 Select your 
paper size

3 Select a 
Media Type
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4. Click the Print button on the left side of the screen. You see additional options:

5. If your photo doesn’t look right in the preview, click the Back button and change 
your settings. (Click the Detailed Preview button for a closer look.)

6. Select the number of copies you want to print.

7. Leave the Exif Print box checked for the best results when printing photos 
containing Exif Print data (not applicable to OS X).

8. Click the Print button at the top of the screen.

� Windows: Your pictures are printed.

� Macintosh OS 8.5.1 to 9.x: You see the Print window; click Print. Your 
pictures are printed.

� Macintosh OS X: You see the Print window. Select Printer Settings from 
the Copies & Pages pull-down menu. Then select your Media Type and other 
print settings as necessary, and click Print.

Store your prints in resealable plastic bags, photo albums, or glass-covered picture 
frames. Keep your pictures and unused paper away from high temperatures, humidity, 
and direct sunlight. Make sure you return unused paper to its original package.

Select the 
number of copies 
you want to print

Leave this box checked 
for the best printed 
output using Exif Print 
data, if available
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Maintaining Your Printer

This chapter describes maintenance procedures to keep your printer working at its 
best, and preparation steps for moving your printer. 

� “Cleaning the Print Head” below

� “Replacing an Ink Cartridge” on page 29

� “Aligning the Print Head” on page 34

� “Cleaning the Printer” on page 35

� “Transporting the Printer” on page 36

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing from the image, 
you may need to clean the print head. This unclogs the nozzles so they can deliver ink 
properly. Print head cleaning uses ink, so clean it only if quality declines. 

This section explains how to clean the print head using the Head Cleaning utility 
(available only when your printer is connected directly to your computer, not over a 
network.) 

You can also clean the print head by holding down the 

 

b maintenance button on the 
printer for three seconds (when the red 

 

b error light is off). 

For more information about cleaning the print head, see your Print Show movies; 
select the  EPSON Printer Information Center icon on your desktop.

Caution: When you don’t turn on your printer for a long time, the print quality can 
decline, so turn it on at least once a month to maintain good print quality.
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Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red 

 

b error light is 
off. (If the red light is flashing or on, you may need to replace the ink cartridge; 
see page 29 for details.)

2. Do one of the following:

� Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

� Macintosh: 
OS 8.5.1 to 9.x: Open the File menu and choose Page Setup or Print. Click 
the  Utility button, then click the  Head Cleaning button.

OS X: Open the Applications folder and select EPSON Printer Utility. 
Select C62 Series in the printer list, click OK, and select Head Cleaning.

3. Follow the instructions on the screen to clean the print head. Cleaning takes 
about 30 seconds, during which the printer makes some noise and the green 

 

P power light flashes. 

Caution: Never turn off the printer while the 

 

P power light is flashing, unless the 
printer hasn’t moved or made noise for more than 5 minutes.

4. When the green 

 

P power light stops flashing, make sure paper is loaded in the 
printer and click Print Nozzle Check Pattern. Then click Print. The nozzle 
check pattern prints (see the next section for details). 

5. If the nozzle check pattern has no gaps or lines, click Finish.

If the pattern has white lines, click Clean to clean the print head again. 

If you don’t see any improvement after cleaning three or four times, check the 
solutions beginning on page 43. You can also turn the printer off and wait 
overnight—this allows any dried ink to soften—and then try cleaning the print 
head again.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. 
Each colored square should be solid, with no 
gaps or lines, as shown:

� If your printout looks okay, you’re done. 

� If you see any white lines or gaps, clean 
the print head again; see page 28 for 
instructions. 

Replacing an Ink Cartridge

When the red 

 

b light flashes, an ink cartridge is low on ink. (You may also see a 
message on your screen.) This is a good time to make sure you have a new cartridge. 
When the red 

 

b light stays on, you need to replace one of the cartridges.

Note: The red 

 

b error light also comes on if your paper runs out or is jammed, so 
make sure you check your paper before replacing a cartridge.

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the red 

 

b light is off.

Checking the Ink Supply

Windows: Double-click the  icon in the 
your taskbar. If a cartridge is low on ink, you 
see a window like the one on the right:

Or right-click the  icon and select
 Ink Monitor to see your ink levels. Click 

Buy Now to launch your web browser and 
order ink cartridges online.
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Macintosh OS 8.5.1 to 9.x: Open the File menu and 
choose Print. Click the  ink icon. 

Macintosh OS X: Choose Applications > EPSON 
Printer Utility > C62 Series > Status Monitor.

You see a window like the one on the right:

Click a cartridge image to display information about the 
cartridge.

Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

� Black ink cartridge: T040120

� Color ink cartridge: T041020 

(May be labeled T040 or T041.)

Caution: To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your printer not covered by 
EPSON’s warranty.

When you need new ink cartridges, contact your dealer or call the EPSON Store  
at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please 
call (800) 463-7766 for dealer referral. 

Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the printer, never move the print head by hand.

You cannot print if either ink cartridge is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement. Otherwise the ink 
remaining in the print head nozzles may dry out.

SM
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing an 
ink cartridge, you must complete all the steps in one session. 

1. Make sure the printer is turned on and not printing (the green 

 

P power light 
should be on, but not flashing). Then open the printer cover.

2. Press the 

 

e ink replacement button. The 
print head moves towards the center and 
the green 

 

P power light flashes.

The red 

 

b error light also begins to flash 
or remains on. 

� If it flashes at the same speed as the 
green 

 

P power light, replace the black 
cartridge. 

� If it flashes twice as fast as the green 

 

P power light, replace the color cartridge. 

� If it remains on, replace both cartridges.

Note: You can also use the Status Monitor to 
find out which cartridge is out of ink. See 
page 29 for more information.

The color cartridge is on the right and the 
black is on the left. 

3. Pull up the ink cartridge clamp. The 
cartridge rises up from its holder.
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4. Lift the cartridge out of the printer and 
dispose of it carefully.

5. Unwrap the new ink cartridge. Then 
remove only the yellow tape seal on top. 

6. Lower the new cartridge down into 
the holder.

Make sure the tabs rest on the hooks 
in back.

Caution: Don’t place the cartridge 
tabs under the hooks; you may 
damage the clamp when you close it.

black cartridge color cartridge

Caution: You must remove the yellow tape from 
the top of the cartridge or you will permanently 
damage it. Don’t try to remove the clear seal 
underneath the cartridge.

Don’t touch the green circuit board on the back of 
the cartridge; you may inhibit normal operation 
and printing. 

hooks
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7. Press down firmly on the ink cartridge 
clamp until it snaps in place.

8. If you need to replace the other ink 
cartridge, repeat steps 3 through 7 before 
continuing with step 9.

9. Press the 

 

e ink replacement button and 
close the printer cover. The printer begins 
charging the ink delivery system.

The green 

 

P power light flashes and the 
printer makes noise. Charging takes about 
half a minute. When it’s finished, the green 

 

P power light stops flashing and stays on, 
and the red 

 

b error light goes out.

Caution: Never turn off the printer while the 
green 

 

P power light is flashing, unless the 
printer hasn’t moved or made noise for more 
than 5 minutes.
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Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see white or black horizontal 
banding, you may need to align the print head. 

Note: Your printer must be connected directly to your computer (not over a 
network) to use the Print Head Alignment utility. 

1. Turn on the printer.

2. Load plain, letter-size paper.

3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen) and select Print Head Alignment.

Macintosh OS 8.5.1 to 9.x: Open the File menu and choose Page Setup or 
Print. Then click the  Utility button. In the Utility menu, click the  Print 
Head Alignment button.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select C62 Series in the printer list, click OK, and select Print Head 
Alignment.

4. Follow the instructions on the screen to 
print a test page. You see this window:

5. On the printed page, select the pattern 
with the two vertical lines most precisely 
printed on top of each other. You may 
need to use a magnifying glass or loupe.

Select one pattern each for rows 1, 2, and 3. Then enter the number of the best 
pattern for each row in the corresponding boxes on the screen. Then click Finish.

If you can’t find an aligned pattern, click Realignment to print another test page, 
then repeat this step.
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Cleaning the Printer 

To keep your printer working at its best, you should clean it several times a year. 

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.

2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet 
feeder.

3. Clean the exterior of the printer with a 
soft, damp cloth. 

4. Clean ink out of the printer’s interior 
with a soft, damp cloth.

Warning: Don’t touch the gears inside the printer.

Caution: Be careful not to wipe the carriage shaft.

Never use a hard or abrasive brush, or alcohol or paint thinner for cleaning; they 
can damage the printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils 
inside the printer.

Don’t use any cleaning sheets included with special paper; they may jam inside 
the printer.

Don’t touch the carriage shaft

Clean 
here
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Transporting the Printer 

If you move your printer some distance, you need to prepare it for transportation in 
its original box or one of a similar size. 

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

1. Turn on the printer, wait until the print head locks in the far right position, then 
turn off the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect the printer 
cable from the printer.

3. Remove any paper from the printer and remove the paper support.

4. Open the printer cover. Secure the ink 
cartridge holder to the printer with tape as 
shown, then close the printer cover.

Caution: Be sure to remove the tape after 
installing the printer in its new location.

5. Push in the output tray extension and close 
the tray.

6. Repack the printer and its attachments in 
the original box using the protective 
materials that came with them.

Keep the printer level as you transport it. 

After transporting the printer, remove the tape securing the print head and test your 
printer. If you notice a decline in print quality, clean the print head (see page 27); if 
output is misaligned, align the print head (see page 34). 

Tape the ink cartridge 
holder to the printer case
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Solving Problems

This chapter gives you the basics for diagnosing and solving printer problems. 

First see “Diagnosing Printer Problems” on page 39 to help determine what the cause 
of the problem may be. Refer to the pictures on page 38 if you need help identifying 
parts of the printer.

Tip: It’s a good idea to check EPSON’s support web site periodically for free 
updates to your printer driver. Visit http://support.epson.com. Download 
instructions are posted for your convenience.

Then see these sections for solutions:

� “Setup and Software Installation Problems” on page 41

� “Printer Problems” on page 42

� “Print Quality Problems” on page 43

� “Paper Feeding Problems” on page 45

� “Miscellaneous Printout Problems” on page 45

� “Uninstalling and Reinstalling Printer Software” on page 47

� “Where To Get Help” on page 48
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Printer Parts

Power button 
and light

Maintenance button 
and error light

Ink replacement button

Paper support

Printer cover

Output tray extension

Output tray

Left edge guide

Ink cartridges and 
print head
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Diagnosing Printer Problems

First, check the printer’s lights as described below, or run a printer check as described 
on page 40.

Lights Explanation

Green 

 

P power light 
flashes

The printer is receiving a print job, charging ink, or cleaning the
print head.

Red 

 

b light is on Your paper ran out, ink ran out, or paper is jammed. You may also 
see a message on your screen.

� If paper is out, load more paper, then press the 

 

b maintenance button to resume printing. 

� If paper is jammed, first press the 

 

b maintenance button 
to eject the paper. If that doesn’t work, turn off the printer, 
open the cover, and remove all paper, including any torn
pieces. Then turn on the printer, reload paper, and press the 

 

b maintenance button.

� If you see an ink out message on your screen, you need to 
replace one of your ink cartridges. See page 29 for details.

Red 

 

b light flashes One of the ink cartridges is low. Make sure you have a replacement 
cartridge. To determine which cartridge is low, check the ink level 
as described on pages 29 and 30.

Green 

 

P power 
light is off and red 

 

b error light is on

Paper may be blocking movement of the print head. Turn off the 
printer, open the cover, and remove any jammed paper or other 
foreign objects. Then turn the printer on again. If the lights are still 
on, contact your dealer or EPSON; see page 48 for contact 
information.

Green 

 

P power light 
and red 

 

b light

 

 
flash

The printer may have an internal error. Turn off the printer, wait a 
few seconds, and turn it on again. If the lights are still flashing, 
contact your dealer or EPSON; see page 48 for contact information.

Green 

 

P power light 
and red 

 

b light are 
on after installing an 
ink cartridge

One of your ink cartridges is installed incorrectly. Follow the 
instructions on pages 31 to 33 to remove and reinstall the 
cartridges.



40 Solving Problems

Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer 
or some other source.

1. Turn off your printer and computer.

2. Disconnect the printer’s interface cable.

3. Load letter-size paper in the printer.

4. Hold down the 

 

b

 

 maintenance 
button, then press and release the 

 

Ppower button. Continue holding 
down the 

 

b

 

 maintenance button until 
the green 

 

P power light flashes, then 
release it.

The printer prints one page showing its 
ROM version number, and a nozzle 
check pattern. (If the pattern has lines 
or gaps through it, clean the print head; 
see page 27.)

� If the check page prints, the problem probably lies in your software settings, 
the interface cable, or your computer. Your software may not be installed 
correctly.

� If the check page doesn’t print, you may have a problem with your printer. 
Try the suggestions in “Problems and Solutions” beginning on page 41. If 
nothing works, contact your dealer or EPSON as described on page 48.

5. Turn off the printer after it prints the check page. Then reconnect the cable and 
turn on your printer and computer.



Solving Problems 41

Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink 
cartridge installation.

� When you install ink cartridges, 
the printer must charge its print 
head for a few minutes. Wait 
until it’s finished (the green 

 

P power light stops flashing) 
before you turn off the printer, 
or it may use excess ink the next 
time you turn it on. 

� Make sure the ink cartridge 
clamps are locked down 
completely and no packing 
material remains in the printer. 
Turn off the printer, wait a 
moment, then turn it back on to 
clear the error.

You’re having problems installing 
the printer software.

� Turn on your printer and make 
sure its cable is securely 
connected at both ends. Follow 
the installation steps on the 
Start Here sheet, and make sure 
your system meets the 
requirements on pages 57 
and 58.

� Close your other programs, 
including screen savers and virus 
protection software, and install 
the printer software again.

� If the C62 Series icon doesn’t 
appear in the Macintosh 
Chooser, you may have too 
many items in the Chooser. 
Delete any unused items.

� If you see an error message with 
Windows 2000, you may not 
have software installation 
privileges. Contact your System 
Administrator.

� If you’re using Windows and 
the USB port, make sure your 
system was not upgraded from 
Windows 95; the USB driver 
may not install correctly.

� Make sure the USB Controller 
is working properly in Device 
Manager. See your Windows 
help system for details.

� If you’re printing over a 
network, see your on-screen 
Reference Guide for instructions 
on configuring your printer.
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Printer Problems

Only the

 

 green 

 

P power light is 
on, but nothing prints.

� Make sure the interface cable is 
securely connected at both ends 
and meets the system 
requirements on pages 57 
and 58.

� Run a printer check as described 
on page 40. If the check page 
prints, make sure your software 
is installed correctly. 

� If you’re printing on a network, 
you need to set up your printer 
for network printing, as 
described in your on-screen 
Reference Guide.

The printer sounds as though it is 
printing, but nothing prints.

� Make sure the print head 
nozzles are not clogged. To 
clean the print head, see 
page 27.

� The printer won’t operate 
properly if it’s tilted or at an 
angle. Place it on a flat, stable 
surface.

Your printer makes noise when 
you turn it on or after it has been 
sitting for a while.

Your printer is performing routine 
maintenance.

Printing is too slow.

Make sure your system meets the 
requirements listed on pages 57 
and 58. If you’re printing a 
high-resolution image, you need 
more than the minimum 
requirements. You may also need to:

� Clear space on your hard drive 
or run a defragmentation utility.

� Close programs that you’re not 
using.

� Increase your system’s memory.

For the fastest printing, try these 
tips:

� Select Draft as the Quality type 
(Windows) or set the 
Quality/Speed slider to Speed 
(Macintosh).

� In the Advanced window, turn 
High Speed on (Windows) or 
MicroWeave® off and High 
Speed on (Macintosh). 

� If your printer is connected to a 
hub, disconnect any unused 
USB devices.

� If you’re using the parallel port, 
enable ECP/DMA mode on 
your computer’s parallel port. 
See your computer 
documentation or the 
manufacturer for instructions.
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Print Quality 
Problems

You see banding (light lines).

� Clean the print head; see 
page 27 for instructions. 

� Select a higher print quality and 
turn off High Speed mode; see 
page 17 (Windows) or page 20 
(Macintosh) for details.

� Select the correct Type 
(Windows) or Media Type 
(Macintosh) for your paper; see 
page 21.

� Make sure the printable side of 
the paper is face up. It’s usually 
whiter or shinier.

� The ink cartridges may need 
replacing; see page 29.

� Try using Automatic mode 
(Macintosh only); see page 13 
(OS 8.5.1 to 9.x) or page 15 
(OS X).

� Align the print head as 
described on page 34.

Your printout is blurry or 
smeared.

� Make sure your paper isn’t 
damp or curled, or loaded face 
down (the printable side should 
be face up). Reload new paper 
face up.

� Use a support sheet with special 
paper, or try loading your paper 
one sheet at a time.

� Make sure your paper meets the 
specifications listed in the 
on-screen Reference Guide. 

� Use EPSON papers for proper 
saturation and absorption of 
genuine EPSON inks. 

� Align the print head see page 34 
for instructions.
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Your printout is faint or has gaps.

� Clean the print head; see 
page 27.

� The ink cartridges may be old or 
low on ink; see page 29. 

� Select the correct Type 
(Windows) or Media Type 
(Macintosh) for your paper; see 
page 21.

� Make sure your paper isn’t 
damaged, old, dirty, or loaded 
face down. If it is, load new 
paper face up. For best results 
use genuine EPSON paper.

Your printout is grainy.

� Try using a higher quality paper 
or select a higher Quality Type 
(Windows; see page 11) or Print 
Quality (Macintosh OS 8.5.1 
to 9.x; page 13) or (Macintosh 
OS X; page 15).

� Align the print head; see 
page 34 for instructions.

� Increase the image resolution or 
print it in a smaller size; see your 
software documentation.

You see wrong or missing colors.

� Make sure Black Ink Only is off 
(Windows) or Color ink is 
selected (Macintosh), even 
when printing black and white 
photographs.

� Clean the print head; see 
page 27 for instructions.

� The ink cartridges may be old or 
low on ink; see page 29.

� Turn off PhotoEnhance.™ Also 
check if you’re using a special 
effect that alters image colors, 
like Sepia. 

� Try using Automatic mode 
(Macintosh only); see page 13 
(OS 8.5.1 to 9.x) or page 15 
(OS X).

� Try changing the Gamma 
setting; see page 17 (Windows) 
or page 20 (Macintosh).

� Your printed colors can never 
exactly match your on-screen 
colors. However, you can use a 
color management system—
such as ICM (Windows; see 
page 17) or ColorSync 
(Macintosh; see page 19)— to 
get as close as possible.
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Paper Feeding 
Problems

Paper doesn’t feed correctly or 
jams in the printer.

� If paper doesn’t feed, remove it 
from the sheet feeder. Fan the 
edges of the sheets, reload them 
against the right edge (beneath 
the tab), then slide the left edge 
guide against the paper.

� If paper jams, press the 

 

b maintenance button to clear 
the jam. If necessary, open the 
cover and remove any jammed 
or torn pieces. Load new paper 
and press the 

 

b maintenance 
button.

Paper doesn’t eject fully or is 
wrinkled.

� If the paper doesn’t eject fully, 
you may have set the wrong 
paper size. Press the 

 

b

 

 
maintenance button to eject the 
paper, then select the correct 
paper size.

� If it’s wrinkled when it ejects, 
the paper may be damp or too 
thin. Load new paper.

Miscellaneous 
Printout Problems

The image is inverted, as if viewed 
in a mirror.

Turn off Mirror Image (Windows) 
or Flip Horizontal (Macintosh) in 
the printer software, or the mirror 
setting in your program. (If you’re 
printing on EPSON Iron-On 
Transfer Paper, the image should be 
inverted.)

The printer prints blank pages.

� Make sure your printer is 
selected in the Windows Print 
dialog box, or in the Macintosh 
Chooser or Print Center.

� Clean the print head; see 
page 27 for instructions.

You see incorrect characters.

� Make sure the interface cable is 
securely connected at both ends 
and meets the requirements on 
page 57 or page 58.

� Make sure your printer is 
selected in the Windows Print 
dialog box, or in the Macintosh 
Chooser or Print Center.

� If you’re using a switch box or 
USB hub with your printer, 
connect the printer directly to 
your computer instead.
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The margins are incorrect.

� Make sure the paper settings are 
correct for your paper size. See 
page 11 (Windows), page 12 
(Macintosh OS 8.5.1 to 9.x), or 
page 14 (Macintosh OS X).

� Choose the correct margins for 
your paper size. The margins 
must be within the printable 
area of the page; see “Printer 
Specifications” in your 
on-screen Reference Guide.

� Make sure your paper is 
positioned next to the right side 
of the feeder and the left edge 
guide is lightly against the other 
side. Don’t load paper above the 
arrow on the left edge guide.

Image size or position is 
incorrect.

Make sure paper and layout options 
are set correctly.

Too many copies are printing.

Make sure that the Copies option in 
your printer software or program is 
not set for multiple copies.



Solving Problems 47

Uninstalling and Reinstalling Printer 
Software 

You may need to uninstall and then reinstall your printer driver and utilities if, for 
example, you upgrade your Windows operating system. You don’t need to uninstall 
EPSON Film Factory or your EPSON Printer Information Center.

Windows

1. Click Start, and select Programs or All Programs.

2. Point to Epson or EPSON Printers, then select EPSON Printer Software 
Uninstall.

3. In the next window, make sure EPSON Stylus C62 Series is selected and 
click OK. Then follow the on-screen instructions. 

4. Restart your computer, then see the Start Here sheet to reinstall your software 
(Windows 95 and 2000 users see page 49 for installation instructions).

Macintosh OS 8.5.1 to 9.x

1. Insert your printer software CD-ROM. 

2. Double-click  EPSON on your 
desktop, then double-click  
EPSON in the folder that opens. 
The Main Menu appears.

3. Click Install Printer Driver. On 
the installer screen, click the arrow 
in the Easy Install list at the top and 
select Uninstall. Then click the 
Uninstall button at the bottom and 
follow the instructions.

4. Restart your Macintosh, then see the Start Here sheet to reinstall your software.
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Macintosh OS X

1. Open the Applications folder, then the Utilities folder.

2. Select Print Center, select C62 Series, and click the Delete button.

3. Restart your Macintosh, then see page 49 to reinstall your software.

Where To Get Help

If you need help with your printer or Film Factory, see the contact information 
below. If you need help using other software with your printer, see the documentation 
for that software for technical support information. 

EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed below:

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON 
Store at (800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, 
please call (800) 463-7766 for dealer referral.

Service Access

World Wide Web From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download 
drivers and other files, look at product documentation, access 
troubleshooting information, and receive technical advice 
through e-mail.

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your SoundAdvice  
Express Code is 70405. Use this code to quickly select the EPSON 
Stylus C62 in SoundAdvice.

SM
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Installing Your Printer Software

Before installing your printer software, follow the steps on the Start Here sheet to set 
up your printer and connect it to your computer.

If you’re using Windows XP, Windows Me, or Windows 98, or Mac OS 8.6 to 9.x, 
follow the software installation instructions on the Start Here sheet.

If you’re using one of the operating systems below, follow the instructions in this 
chapter to install your printer software:

� “Installing Printer Software on Mac OS X” below

� “Installing Printer Software on Windows 2000” on page 53

� “Installing Printer Software on Windows 95” on page 55

Installing Printer Software on Mac OS X

First you’ll install your printer software for OS X applications, then you’ll restart your 
Macintosh in OS 9.x and install your printer software for Classic mode applications.

1. Start up your Macintosh in OS X. (Make sure your printer is still on.)

2. Put the EPSON CD-ROM in your CD-ROM or DVD drive and wait a few 
seconds for the CD-ROM to be recognized.

3. Double-click EPSON on your 
desktop. Then select C62Series 
in the window that opens.

Select C62Series
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4. If you set up an administrator 
password, you see this screen. Click 
the lock icon, then enter your 
password, click OK, then click 
Continue.

5. Click Continue, then read and agree 
to the license agreement to continue 
the installation.

6. Select the OS X drive or partition and 
click Continue.

7. When you see the Easy Install screen, 
click Install.

8. Follow the on-screen instructions to complete the installation and restart your 
Macintosh.

9. After your Macintosh restarts, double-click the Film Factory Installer icon 
to install Film Factory; follow the on-screen instructions to install it on your 
system.

10. Click Quit, then close the Film Factory folder.

11. To install the EPSON Printer Information Center, double-click the Printer 
Movies and Manual icon; follow the on-screen instructions to install it on your 
system.

12. Click Quit, and close all open folders.

Click the lock icon
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13. Open the OS X Applications folder, then open the Utilities folder and select 
Print Center.

Note: If you see this screen, click Add.

If C62 Series already appears in the 
Printer list, go to step 16.

14. At the Printer List screen, click Add 
Printer.

15. Select EPSON USB, click C62 Series(USB), then click Add.

Your printer appears in the printer list.

16. Close Print Center and start up your Macintosh in OS 9.x.

Follow the instructions in the next section to install the OS 9.x printer driver and 
optional software for your Macintosh Classic applications.

Select Print Center
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Installing Printer Software for Mac OS 9.x

1. Select EPSON on your desktop, if 
necessary. Then select EPSON in 
the window that opens.

2. Read and agree to the license 
agreement to continue the installation.

3. Click Install Printer Driver and follow the 
on-screen instructions to install the driver 
and restart your Macintosh.

4. After your Macintosh restarts, register your 
printer with EPSON as instructed.

5. Open the Chooser in the Apple® menu. 
Select C62 Series, then select your USB 
port and turn on background printing.

6. Close the Chooser.

7. Select EPSON in the window on your 
desktop again. You see the Main Menu.

8. Click Install EPSON Software Film 
Factory; follow the on-screen instructions 
to install it on your system.

9. When you’re finished, click Exit.

10. Remove the CD-ROM. Keep the 
CD-ROM in case you need to reinstall any 
software later. 

You’re ready to print.
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Installing Printer Software on 
Windows 2000

1. Make sure your printer is set up, connected to your computer, and turned on, as 
described on the Start Here sheet.

2. Turn on your computer.

3. Wait for Windows to detect your printer 
connection and display a screen like this:

Don’t click any buttons on the screen yet.

Note: If this screen doesn’t appear, make 
sure your printer is turned on and connected.

4. Put the EPSON CD-ROM in your 
CD-ROM or DVD drive and wait a few 
seconds for the CD-ROM to be recognized.

5. Click Next.

6. Click the Search for option, then click 
Next.

7. Click CD-ROM drives, then click Next.

8. At the next screen, click Next. 
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9. Installation proceeds automatically. At the 
final Found New Hardware Wizard screen, 
click Finish.

10. After a moment, you see a license agreement 
screen. Read and agree to the license 
agreement to continue the installation.

11. At the Options Menu, click Print a Test 
Page to check your installation. (If the page 
doesn’t print correctly, see page 41 for a 
solution.)

12. Click Install EPSON Software Film 
Factory; follow the on-screen instructions 
to install it on your system. During the 
installation process you see a message about 
installing QuickTime, click Yes and follow 
the on-screen instructions. You don’t need a 
registration number to install QuickTime.

13. Select Install Printer Movies and Manual to install the EPSON Printer 
Information Center on your desktop. It includes helpful printer animations and 
an additional manual.

14. When you’re finished, click Exit.

15. Register your printer with EPSON, then remove the CD-ROM, and restart your 
system. Keep the CD-ROM in case you need to install any software later. 

You’re ready to print.
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Installing Printer Software on Windows 95

1. Make sure your printer is set up, connected to your computer, and turned on, as 
described on the Start Here sheet.

2. Turn on your computer. If you see a New Hardware Found screen, click Cancel.

3. Put the EPSON CD-ROM in your CD-ROM or DVD drive.

4. Read and agree to the license agreement to continue the installation.

5. At the Install Menu, select Install Printer 
Driver and follow the on-screen 
instructions.

6. When you return to the Main Menu, click 
Install EPSON Software Film Factory; 
follow the on-screen instructions to install it 
on your system. During the installation 
process you see a message about installing 
QuickTime, click Yes and follow the 
on-screen instructions. You don’t need a 
registration number to install QuickTime.

7. Select Install Printer Movies and Manual 
to install the EPSON Printer Information Center on your desktop. It includes 
helpful printer animations and an additional manual.

8. When you’re finished, click Exit. 

9. Register your printer with EPSON, then remove the CD-ROM, and restart your 
system. Keep the CD-ROM in case you need to install any software later. 

You’re ready to print.
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Requirements and Notices

This chapter includes system requirements, safety instructions, legal notices, and other important 
information.

Windows System Requirements

To use your printer and its software, your system should have: 

� A Microsoft Windows compatible PC with a Pentium® 233 MHz or faster recommended

� Microsoft Windows 95, Windows 98, Windows Me, Windows 2000, or Windows XP

� At least 64MB of RAM (128MB recommended)

� 100MB of free hard disk space (200MB or more recommended)

� VGA or better display adapter and monitor

� One of the following:

For USB connection: a computer running Windows 98, Windows Me, Windows 2000, or 
Windows XP with a Windows-compliant USB port and a shielded USB “AB” cable up to 6.5 feet 
(2 meters) long.

For parallel connection: a high-speed, bidirectional, IEEE-1284 compliant parallel cable (6 to 10 
feet long) with a D-SUB, 25-pin, male connector for your computer and a 36-pin Centronics® 

compatible connector for the printer.
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Macintosh System Requirements

To use your printer and its software, your system should have: 

� A Power Macintosh® G3, G4, iMac™ or eMac™ with a built-in USB port

� Mac® OS 8.5.1 through OS X 10.1 or higher. (Mac OS 9.0 or later recommended)

� Mac OS 8.5.1 to 9.x: At least 64MB of available RAM (128MB recommended)
Mac OS X: At least 128MB of available RAM (256MB recommended)

� At least 100MB of free hard disk space (200MB recommended)

� VGA display or better

� A shielded USB “AB” cable up to 6.5 feet (2 meters) long.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy efficiency. The 
EPA ENERGY STAR office equipment program is a voluntary 
partnership with the computer and office equipment industry to 
promote the introduction of energy-efficient personal computers, 
monitors, printers, fax machines, and copiers in an effort to reduce air 
pollution caused by power generation.
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Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely 
and effectively:

� Be sure to follow all warnings and instructions marked on the printer.

� Use only the type of power source indicated on the printer’s label.

� Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

� Place the printer near a wall outlet where the plug can be easily unplugged.
Placez l’imprimante près d’une prise de courant où la fiche peut être débranchée facilement.

� Do not let the power cord become damaged or frayed. 

� If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere 
rating.

� Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

� Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

� Leave enough room around the printer for sufficient ventilation.

� Do not place the printer near a radiator or heating vent or in direct sunlight.

� Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

� Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

Caution: Always turn the printer off using the 

 

P power button. Don’t switch off the power 
strip or unplug the printer until the green 

 

P power light is off.

� Do not block or cover the openings in the printer’s case or insert objects through the slots. 

� Except as specifically explained in this manual, do not attempt to service the printer yourself. 

� Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change 
in performance. Adjust only those controls that are covered by the operating instructions.
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Ink Cartridge Safety Instructions

� Keep ink cartridges out of the reach of children and do not drink the ink. 

� Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

� Do not put your hand inside the printer or touch the cartridge during printing.

� Do not move the print head by hand. You may damage the printer.

� Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

� Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use 
up the ink cartridges within six months of first installing them.

� Store ink cartridges in a cool, dark place.

� After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

� Do not shake an ink cartridge; this can cause leakage.

� Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

� Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

� If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

� Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains 
in the proper position.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and receiver.

� Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

� Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: Ink Jet Printer

Model: B162A

Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the first retail purchaser that the EPSON 
printer covered by this limited warranty statement, if purchased and used in the United States or 
Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. Epson also warrants that 
the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified 
usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. 
For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems:  Should your EPSON printer prove defective during the 
warranty period, please call EPSON at (800) 922-8911 for printer diagnostic information and for a 
telephone number if warranty service is necessary. An Epson service technician will provide telephone 
diagnostic service, if needed, and determine whether the printer requires service. If Epson determines 
that service is required, Epson will, at its option, exchange or repair the printer without charge for parts 
or labor.  If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer 
to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and 
U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for 
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securely packaging the defective unit or any requested parts and returning them to Epson within five 
(5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure 
the cost of the replacement printer in the event that you fail to return the defective one. If your printer 
is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, 
where the printer will be fixed and sent back to you. You are responsible for packing the printer and for 
all costs to and from the Epson authorized service center. When warranty service involves the exchange 
of the printer or a part, the item replaced becomes Epson property. The replacement printer or part 
may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another 
model of like kind and quality. Epson’s liability for replacement of the covered printer will not exceed 
the original retail selling price of the covered printer. Exchange products and parts assume the 
remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and 
Canada. This warranty is not transferable and will not apply to products purchased from an end user. 
This warranty does not cover any color change or fading of prints or reimbursement of materials or 
services required for reprinting. This warranty does not cover damage to the EPSON product caused 
by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover 
ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON 
product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not 
responsible for warranty service should the Epson label or logo or the rating label or serial number be 
removed or should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as 
fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson 
products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be 
identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE 
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL 
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE 
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

Epson America, Inc. - P.O. Box 93012 - Long Beach, CA 90809-3012
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Index

Numerics

360 dpi Ink Jet Paper setting, 21

A

Advanced settings, 17 to 20
Aligning print head, 34
Automatic mode, Macintosh, 13, 15, 44

B

Background printing, 13
Banding, 43
Basic printing

Macintosh, 12 to 16
Windows, 10 to 12

Black Ink Only setting, 17, 44
Blank pages, 45
Blurry images, 43
Bright White Paper, 21
Browser, 4
Buttons, 38

C

Cable, printer, 57, 58
Cancelling printing

Macintosh, 13, 16
Windows, 11

Characters, incorrect, 45
Checking printer, 40
Chooser, 41, 45

Cleaning
print head, 27 to 29
printer, 35
sheets, 35

Color Management settings
Mac OS 8.5.1 to 9.x, 19 to 20
Mac OS X, 19 to 20
Windows, 17

Color problems, 44
ColorSync, 15, 19 to 20, 44
Control panel, 38 to 39
Controlling printing

Macintosh, 13, 16
Windows, 11

Copies settings, 46
Custom settings

Macintosh, 19 to 20
Windows, 17 to 18

D

Declaration of Conformity, 62
Default settings, Windows, 12
Documentation, 3 to 6
Double-Sided Matte Paper, 21

E

ECP/DMA mode, 42
Electronic manual, 4 to 6
ENERGY STAR Compliance, 58
Envelopes, 9
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EPSON
help, 48
papers, 21
Printer Information Center, 2, 4 to 6
SoundAdvice, 48
Store, 30, 48
Warranty, 62 to 63

EPSON PhotoCenter, 2
Exif Print, 2, 22 to 26

F

Faint images, 44
FCC Compliance Statement, 61
Film Factory, 2, 23 to 26
Flip Horizontal setting, 45

G

Gamma setting, 17, 20, 44
Glossy media, 21
Grainy prints, 44
Greeting Cards, Glossy Photo, 21

H

Head Cleaning utility, 27 to 29
Help

EPSON, 48
see also Printer Information Center and 

Troubleshooting
High Speed setting, 43

I

ICM (Image Color Matching) setting, 17, 44
Incorrect

characters, 45
colors, 44
margins, 46
size, 46

Ink cartridge
level of ink in, 11, 13, 29 to 30
ordering, 30, 48
problems, solving, 44
replacing, 29 to 33
safety instructions, 30 to 32, 60

Ink Jet Transparencies, 21
Ink level, checking

Macintosh, 13, 30
Windows, 11, 29

Installation problems, 41
Inverted image, 45
Iron-On Transfer Paper, 21, 45

J

Jams, paper, 45

L

Layout problems, 46
Layout settings

Macintosh, 13, 15
Windows, 18

Letterhead, 8
Lights, 31, 38 to 39
Luster Photo Paper, 21

M

Macintosh
basic printing, 12 to 16
Chooser, 41, 45
installing software, 49 to 52
system requirements, 58
uninstalling software, 47

Maintaining printer, 27 to 35
Margins, incorrect, 46
Matte Paper Heavyweight, 21
Matte Paper, Double-Sided, 21
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Media Type setting
Mac OS 8.5.1 to 9.x, 13, 19 to 20, 43
Mac OS X, 15, 19 to 20, 43
selecting correct, 21
Windows, 11, 17, 43

MicroWeave setting, 42
Mirror Image setting, 45
Mirror images, 45
Monitoring ink level

Macintosh, 13, 30
Windows, 11, 29

Movies, Print Show, 2, 4 to 5
Moving printer, 36

N

Network printing, 41
Noise, printer, 42
Nozzle Check, 28 to 29

O

Orientation setting, 11, 12, 14, 25

P

Page Setup, Macintosh, 12, 14
Paper

EPSON, 21
feeding problems, 45
loading, 8 to 9
orientation, 11, 12, 14

Paper Size setting, 9, 11, 12, 14
Parallel port, 42
Photo Paper, 21
Photo Quality Ink Jet Paper and Cards, 21
Photo RPM setting, 17, 20
Photo Stickers, 21
PhotoCenter, EPSON, 2
PhotoEnhance, 44
Premium Bright White Paper, 21
Premium Glossy Photo Paper, 21
Premium Luster Photo Paper, 21

Premium Semigloss Photo Paper, 21
Preprinted paper, 8
Previewing printout, 11, 13, 26
Print dialog box, 10
Print head

aligning, 34
cleaning, 27 to 29

Print Head Alignment utility, 34
Print quality problems, 43 to 44
Print Show movies, 2, 4 to 5
Printer

cable, 57, 58
check, 40
cleaning, 35
control panel, 38 to 39
maintaining, 27 to 35
noise, 42
parts, 38
problems, 39 to 45
properties, 11
transporting, 36

Printer Information Center, 2, 4 to 6
Printing

advanced, 17 to 20
controlling, 11, 13, 16
Macintosh, basic, 12 to 16
Windows, basic, 10 to 12
with custom settings, Macintosh, 19 to 20
with custom settings, Windows, 17 to 18

Problems
diagnosing, 39 to 40
installing software, 41, 49 to 55
miscellaneous, 45
paper feeding, 45
print quality, 43 to 44
printer, 42
solving, 37 to 48

Progress Meter, 11

Q

Quality Type setting, 11, 42, 44
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R

Reference Guide, 4 to 6
Reinstalling software, 47 to 48
Resolution Performance Management (RPM), 

1, 17, 20
RPM, 1, 17, 20

S

Safety instructions, 59 to 60
Self adhesive sheets, 21
Semigloss Photo Paper, 21
Service, 48
Size setting, 9, 11
Slow printing, 42
Smeared printout, 43
Software

installation problems, 41
installing, 49 to 55
problems, solving, 41
reinstalling, 47 to 48
summary, 2
uninstalling, 47 to 48

SoundAdvice, 48
Stickers, 21
System requirements, 57 to 58

T

Technical support, 48
Testing printer, 40
Transfer paper, 21, 45
Transparencies, 21
Transporting printer, 36
Troubleshooting, 37 to 46
Type setting, 11, 42, 43, 44

U

Uninstalling software, 47 to 48
USB

problems, 41
requirements, 57, 58

Utilities
Head Cleaning, 27 to 29
Nozzle Check, 29
Print Head Alignment, 34

W

Warranty, 62 to 63
Windows

basic printing, 10 to 12
default settings, 12
installing software, 53 to 55
system requirements, 57
uninstalling software, 47
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